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## Getting StartedKK starting$$ Getting Started Getting Started

WinFrotz is a Z-MachineZ_Machine interpreter (or more properly, emulator) that lets you load interactive fiction story filesstory_file and play them under Windows 95 or Windows NT.  The most widely known examples of interactive fiction are the old InfocomInfocom adventure games; WinFrotz will play almost all of those (see compatibilitycompatibility notes).

However there are plenty of more recent interactive fictions works available; in fact, there are more works of interactive fiction released after Infocom ceased producing them than Infocom released themselves.  This is mainly do to the freely available compilers to create these files.

To get going with WinFrotz all you need to do is track down some story files and load them up. There are a few in the WinFrotz distribution archive you can try out, or if you have one of the Infocom games (including the re-release of them by Activision) all you need to do is load the .dat file from it and you can play.  Or you can go get some of the more recent, public domain and shareware story files from the interactive fiction repository on the internet at ftp.gmd.de.

For an easy starting point you can head to the WinFrotz web pages which have links and pointers for locations of story files, background info, etc.  They are located at:

http://www.cris.com/~Twist/WinFrotz/

(Obtaining story files is more completely discussed in Obtaining Story Filesget_games)
Have fun!

## menu_fileKK files: managing $$ File menu commands File menu commands

The File menu offers the following commands:

RestartHID_FILE_NEW
Restart the current story file.
Open StoryHID_FILE_OPEN
Opens a new story file
Openopen_file
Opens a data file such as a saved game (only works after a story is loaded)
SaveHID_FILE_SAVE
Saves an opened document using the same file name.
PrintHID_FILE_PRINT
Prints a document.
Print PreviewHID_FILE_PRINT_PREVIEW
Displays the document on the screen as it would appear printed.
Print SetupHID_FILE_PRINT_SETUP
Selects a printer and printer connection.
ExitHID_APP_EXIT	

Exits WinFrotz.


## menu_editEdit menu commands

The Edit menu offers the following commands:

UndoHID_EDIT_UNDO
Reverse previous editing operation.
CutHID_EDIT_CUT
Deletes data from the document and moves it to the clipboard.
CopyHID_EDIT_COPY
Copies data from the document to the clipboard.
PasteHID_EDIT_PASTE
Pastes data from the clipboard into the document.

	
## menu_viewKK fonts$$ Selecting (View menu)KK display options$$ Selecting (View menu)KK graphics$$ Selecting (View menu) View menu commands

The View menu offers the following commands:

ToolbarHID_VIEW_TOOLBAR
Shows or hides the toolbar.
Status BarHID_VIEW_STATUS_BAR
Shows or hides the status bar.
Fontsfont_choices
Select the fonts used for WinFrotz
Display OptionsHIDD_DIALOG_DISPLAY
Control the WinFrotz screen properties and how the program chooses to indicate various display styles
GraphicsHIDD_GRAPHICS
Control how WinFrotz handles V6version_6 (graphical) Infocom games such as Journey, Arthur, etc.

## menu_colorsKK colors$$ Selecting (Colors menu) Colors menu commands

This menu consists of six options: Foreground, Background, Status Foreground, Status Background, Emphasis Text, and Bold Text.  Selecting any of these will bring up a standard Windows Color dialogAFX_HIDD_COLOR.  If you are in dual color mode (the default, and changed by the Display OptionsHIDD_DIALOG_DISPLAY dialog in the View menu) only the first two choices will be available.

It is possible to select a color and not immediately see an effect; for instance, if you change the Bold color and have told WinFrotz via the Display OptionsHIDD_DIALOG_DISPLAY dialog to print bold as an actual bold font, you won’t see any difference.  Also, many games simply do not have Bold or Emphasis text in them.

The Status colors are slightly misnamed; what you are really doing is setting the colors for reverse printed text.  Generally the status area is printed completely in reverse, but sometimes text is also printed in the display are that way as well.

## menu_helpHelp menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help TopicsHID_HELP_INDEX
Offers you an index to topics on which you can get help.
AboutHID_APP_ABOUT
Displays the version number of this application.

## menu_optionsKK sound$$ Options MenuKK aliases$$ Options Menu Options menu commands

The options menu offers the following commands, which affect the way WinFrotz plays a story file:
AliasesHID_OPTIONS_ALIAS
Manages aliases for text input.
DebuggingHID_OPTIONS_DEBUGGING
Sets various debug flags for the Z-machine.
SoundHID_OPTIONS_SOUND
Controls volume, and whether WinFrotz plays sounds at all.
Auto LoadHID_OPTIONS_AUTO_LOAD
Controls which story (if any) is automatically loaded when WinFrotz is started. You can use this to bookmark the story you are currently playing and not have to load it manually next time.
Undo Last TurnHID_OPTIONS_UNDO_GAME
Allows you to take back your last action in the game.


## Z_Machine The Z-Machine

The Z-Machine was a computer that didn’t exist, but had plenty of programs written for it.  This was an idea of the original founders of InfocomInfocom; to come up with a computer design specifically built to play interactive fiction (adventure) stories.  They designed the ‘operating system’ of this mythical computer to support what they needed to write adventure games and that was pretty much it.

When they wrote actual adventures, they of course didn’t have a Z-Machine handy, so instead programs were written on other computers that emulated the behavior of the Z-machine.  Since the capabilities required were clearly defined by the Z-Machine structure itself, it made porting their adventure games to a variety of platforms easier.  All they had to do was write a Z-Machine emulator for the platform in question and they would then be able to run all the Infocom adventures.

This worked out well for people who wanted to play the Infocom adventures later on.  The same principle that made Z-Machine emulators versatile for Infocom works for us today; WinFrotz is basically a Z-Machine emulator designed specifically for Windows.  Additionally, after Infocom more or less ceased to exist, programmers reverse engineered the capabilities of the Z-Machine and wrote their own compilers to create Z-Machine code.  So today it is easy to create a Z-Machine program; and since so many Z-Machine emulators exist you can be assured a Z-Machine program will run on a whole variety of computer types, all the way from advanced Unix workstations to palmtop machines.


## HID_FILE_NEWKK files: managing $$ File New command Restart command (File menu)

Use this command to restart the current story file. You will begin from the beginning as if you had just loaded the story. It is not required to Restart before loading a saved game position.

You can open a different story file from the one you are playing using the Open Story commandHID_FILE_OPEN.

Shortcuts
Toolbar:	{bmc filenew.bmp}

## start_story Starting a Story

To start a story file, you simply have to open it using the File menu option Open StoryHID_FILE_OPEN.  After it is opened WinFrotz will automatically start the story at the beginning, which usually means displaying some text for you to read as an introduction.  If you have previously played the same story file and want to pick up where you left off, you can load a saved gamesaved_game using the Openopen_file command from the File menu.


## HID_FILE_OPENKK files: managing $$ File Open command Open Story command (File menu)

Use this command to open a story filestory_file from disk. WinFrotz will prompt you for confirmation if you already have a story loaded and choose to play a different one.

Opening a story is accomplished using the standard Windows File Open dialogAFX_HIDD_FILEOPEN

Shortcuts
Toolbar:	{bmc fileopen.bmp}


## AFX_HIDD_FILEOPENKK aliases$$ File Open DialogKK recording$$ File Open Dialog File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open.  This box lists files with the extension you select in the List Files of Type box. 
List Files of Type
Select the type of file you want to open:
.dat,.z3,.z5,.zip (etc.)	Story filesstory_file
(Do not confused Z-Machine .zip files with compressed .zip files. Infocom was using this extension long before PkWare invented ZIP - WinFrotz cannot load compressed files).
.sav		Saved game file
.frc 			Alias listalias_file
.rec			Recording filerecording_file
Drives
Select the drive in which WinFrotz stores the file that you want to open. 
Directories
Select the directory in which WinFrotz stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

## HID_FILE_SAVE## HID_FILE_SAVE_GAME## HID_FILE_SAVE_ALIAS## HID_FILE_SAVE_REC KK files: managing $$ File Save commandKK transcript$$ SavingKK aliases$$ SavingKK recording$$ Saving Save command (File menu)

Use this command to save data from your session, such as a saved gamesaved_game, alias listalias_file, recordingrecording_file, or transcripttranscript_file. In each case WinFrotz will provide you with a standard dialog box and a suggested file name.  While you can change the base file name to anything you like, it’s recommended that you leave the extension as is so finding the file will be easier when you want to load it.

Recording filesrecording_file are something of a special case.  To correctly save a recording file you will need to use the File/Save/Recording menu twice, once to start the recording and once to stop it.  Otherwise WinFrotz wouldn’t be able to tell exactly how much you want to record.  There is also a hot-key for recording: Alt-R.

Shortcuts
Toolbar:	{bmc filesave.bmp}
(The toolbar shortcut will automatically select Save->Game only, for others you need to use the menu option)


## open_file## HID_FILE_GAME## HID_FILE_ALIAS## HID_FILE_RECKK aliases$$ Loading Open command (File menu)

Use this command to open data files other than the stories themselves, such as a previously saved gamesaved_game, alias listalias_file for your current story file, or a recordingrecording_file of actions from this story.

If you have an alias file in the original directory containing the story, and it is named with the same base name as the story itself, it will be loaded automatically when the story is loaded. So if your story file was ZORK1.DAT and there was an alias file of ZORK1.FRC in the same directory, there is no need to load it (it was loaded when ZORK1.DAT was). This does not apply to recording or saved games.

Opening operations are accomplished using the standard Windows File Open dialogAFX_HIDD_FILEOPEN

## saved_game Saved game (.sav extension)

Saved games will save your position in the story (including any inventory items, etc.).  Later you can reload the saved game file (with the appropriate story file already loaded) and WinFrotz will pick up in the exact spot you left off with the save.

Save early and save often.  Saved game files are small and it is possible in many games (particularly the old InfocomInfocom ones) to get into no-win situations without being aware of it at the time.

## story_file Story File (.dat, .z? extension)

Story files are the data that WinFrotz works with. They are often thought of as ‘adventures’ because that was used to describe all of the early InfocomInfocom products; however there have since been many story files that are not adventures in the classic sense.

An example of a story file might be Planetfall (one of the Infocom adventures) or Curses, a much more recent work of interactive fiction. 

Note: Do not confused Z-Machine .zip files with compressed .zip files. Infocom was using this extension long before PkWare invented ZIP - WinFrotz cannot load compressed files).

## recording_fileKK recording$$ File Description Recording File (.rec extension)

A recording file keeps a list of the commands that you type in to WinFrotz, so you can read them in later and play them back in the exact sequence you typed them in the first time.

Recording files are occasionally useful over saved games because they will display all of the story text from one point to the next; whereas a saved game simply puts you at the spot where it was saved.
## transcript_fileKK transcript$$ Description Transcript

A transcript is a recording of the text to appear in window 0 (the main text window) for the time you have been playing.  WinFrotz maintains a cumulative transcript of everything that has occured for the current story file, but the scrollback buffer only displays about 32K of that.  Saving the transcript allows you to view the entire contents.

## alias_fileKK aliases$$ File Description Alias File (.frc extension)

Alias files keep a record of abbreviations of your choosing for commonly typed commands in a game. For instance, instead of typing in the robot form in slot one repeatedly you might decide to abbreviate it rbf.  An alias file will permanently record that abbreviation so it is available for you next time you run that story file.

Take care in picking aliases; remember many objects can be referred to by shortened versions of their own name.  Abbreviating sailor as sai and having the game confuse that for the word sail for instance.


## AFX_HIDD_FILESAVEFile Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name
Type a new filename to save a document with a different name.  A filename can contain up to eight characters and an extension of up to three characters.  WinFrotz adds the extension you specify in the Save File As Type box.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 


## HID_FILE_MRU_FILE1 KK files: managing $$ File 1, 2, 3, 4 command 1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed.  Choose the number that corresponds with the document you want to open.

## HID_APP_EXITKK exit $$ File Exit command Exit command (File menu)

Use this command to end your WinFrotz session.  You can also use the Close command on the application Control menu.  WinFrotz prompts you to save documents with unsaved changes when you select File/Exit but not when you use Alt+F4 or the application Control menu.

Shortcuts
Mouse:	Double-click the application's Control menu button.
	{bmc appexit.bmp}
Keys:	ALT+F4
## HID_EDIT_UNDO Undo/Can't Undo command (Edit menu)

Undo will take back your last edit action on the input line. This is different from the WinFrotz game undo, which takes back your last game action. That option is accessed with Alt-U or from Options Undo..

Shortcuts
Toolbar:	{bmc editundo.bmp}
Keys:	CTRL+Z or
	ALT-BACKSPACE	


## HID_EDIT_REDORedo command (Edit menu)

WinFrotz does not support Redo

## HID_EDIT_CUTCut command (Edit menu)

WinFrotz does not yet support the cut command in the main window.  To copy text, use the Scrollback buffer (Ctrl-L), highlight the text, and Ctrl-C to copy it.

Shortcuts
Toolbar:	{bmc editcut.bmp}
Keys:	CTRL+X


## HID_EDIT_COPYCopy command (Edit menu)

WinFrotz does not yet support the copy command in the main window.  To cut text, use the Scrollback buffer (Ctrl-L), highlight the text, and Ctrl-C to copy it..

Shortcuts
Toolbar:	{bmc editcopy.bmp}
Keys:	CTRL+C


## HID_EDIT_PASTEPaste command (Edit menu)

Pastes text from the clipboard into the current input line.

Shortcuts
Toolbar:	{bmc editpast.bmp}
Keys:	CTRL+V


## HID_VIEW_TOOLBARKK toolbar $$ View Toolbar command Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in WinFrotz, such as File Open.  A check mark appears next to the menu item when the Toolbar is displayed.

See ToolbarAFX_HIDW_TOOLBAR for help on using the toolbar.

## AFX_HIDW_TOOLBARKK toolbar $$ toolbar Toolbar
{bml hlptbar.bmp}

The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar provides quick mouse access to many tools used in WinFrotz,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click	To
{bmc filenew.bmp}	Open a new document.

{bmc fileopen.bmp}	Open an existing document.  WinFrotz displays the Open dialog box, in which you can locate and open the desired file.

{bmc filesave.bmp}	Save the active document or template with its current name.  If you have not named the document, WinFrotz displays the Save As dialog box.

{bmc fileprnt.bmp}	Print the active document.

{bmc editcut.bmp}	Remove selected data from the document and stores it on the clipboard.

{bmc editcopy.bmp}	Copy the selection to the clipboard.

{bmc editpast.bmp}	Insert the contents of the clipboard at the insertion point.

{bmc editundo.bmp}	Reverse the last editing.  Note:  You cannot undo some actions.


## HID_VIEW_STATUS_BARKK status bar $$ View Status Bar CommandStatus Bar command (View menu)

Use this command to display and hide the Status Bar.  Typically you should leave this on, as it displays valuable data such as the action to be selected by the current menu item, dimensions of your screen, and various keyboard states.

See Status BarAFX_HIDW_STATUS_BAR for help on using the status bar.

## AFX_HIDW_STATUS_BARKK status bar $$ status barStatus Bar
{bml hlpsbar.bmp}

The status bar is displayed at the bottom of the WinFrotz window.  To display or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus.  This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them.  If after viewing the description of the toolbar button command you wish not to execute the command, then release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator	Description
??x??	Character dimensions of the screen
UNLOCK or LOCK	Shows whether the screen is locked to prevent resizing.
INS or OVR	Text insertion mode is selected, or overstrike mode is selected
CAP	The Caps Lock key is latched down.
NUM	The Num Lock key is latched down.
SCRL	The Scroll Lock key is latched down.
??:?? ??	The current time (real, not from the game) in AM/PM mode.

## font_choices Font Choices (View Menu)

From the Fonts item on the View menu, you can choose either your Display Fontdisplay_font or your Status Fontstatus_font.

## display_font## HID_VIEW_FONTKK fonts$$ Display Font Display Font( View Menu; Fonts)

The display font is the font uses for the primary display text (in Z-MachineZ_Machine code this is window 0).  For most works of interactive fiction the screen is typically split into two areas; with the primary display (window 0) being most of the lower portion of the screen and the status area (window 1 or 7) occupying the upper portion.  The display font will change the font that is displayed in the lower portion of the window.

WinFrotz won’t allow you to change the display font within a game unless you are currently inputting a line of text; you can’t change the font at a MORE prompt for instance or while the screen is printing.  You can always change the font if there is no story loaded.  If you change the font while a game is playing, it will affect all text printing in window 0 from that point onward, not the text that is already on the screen.  However if you have some text on the input line at the time you change the font, that will be reprinted with the newer font, which can work well to test the appearance of the new font you’ve selected.

Note that while the screen format described above holds as a general rule it is not applicable to all games; there is no specific requirement that the bottom part of the screen be window 0 or even that window 0 be displayed at all.  If you are running a story file that only runs window 1 for example, changing the display font won’t produce any visible results.

## status_font## HID_VIEW_STATUS_FONTKK fonts$$ Status font Status Font (View Menu; Fonts)

The status font is the font generally used for a status area at the top of the screen common to most story files.  There are special restrictions to the status font:
	* The status font must be fixed-pitch; WinFrotz will enforce this by only allowing you to choose fonts of the appropriate type.
	* A status font cannot be selected that is too large for the current display; that is, if the status area were re-printed with the selected font and the result was wider than the total width of the Windows desktop, WinFrotz will complain and ask you to re-select the font.  If the resulting display would fit on the desktop, WinFrotz will resize your screen to new required size.  This is required because almost no games work correctly when the status area is resized after a game is started; it must remain the same size (in character dimensions) as it was when the story was first run.
	* Some version 4 and 5 Z-Machine games may produce errors if you change the status font on the fly, epecially if you choose nonsensical values (very large or very small fonts). WinFrotz attempts to prevent you from making any bad mistakes here - but if things go wrong after you change the status font, save your game, change it back to the size it was before, and restart.

Having different sized status and display fonts was never really a feature the Z-MachineZ_Machine was designed to support.  The most compatible way to run WinFrotz (and the settings that most closely resemble the platforms the Z-Machine was developed on) is to run the same fixed pitch font for the status and display areas.  However there are only a few cases where doing otherwise causes problems, and they are generally outweighed by the much more readable output when larger, variable pitch fonts are used.

There are several games that will use the status font in the regular display area - the status font is really the Z-Machine fixed font.  WinFrotz supports this with no problem.  Generally it is desirable to have a status font that is smaller than the display font.

Do not confuse the Z-Machine status area, generally at the top of the WinFrotz display but not required (and so not present in some story files) with the status bar that is maintained by Windows at the bottom of the screen.

## HIDD_DIALOG_DISPLAY## HID_VIEW_DISPLAY_OPTKK display options$$ Display Options Dialog Display Options (View menu)
This dialog box controls various aspects of the WinFrotz display.
Show Emphasis/Bold as:
The left hand categories, Show Emphasis as: and Show Bold as: control what WinFrotz will do when asked to print either Emphasis or Bold fonts by the story file.  You can choose to print these fonts as their specific font style (Emphasis or Bold), print them like normal text but with a special color (selected from Colors menu), or to show no special effect at all.  In addition for Emphasis you can tell WinFrotz to display it as underline, as this was an option on some Z-Machine interpreters in the past.

Display Mode:
Selecting the Color options above or selecting Use full color in the right hand Display Mode area will result in WinFrotz prompting you to make sure you wish to make that change.  Full color mode allows a whole variety of color options but slows WinFrotz down considerably.  How much the program is slowed down will depend on the color resolution of your Windows desktop; truecolor being the slowest.  This should be an issue only on the slowest of machines capable of running Win95 or NT. In general however much slower it is in color mode, WinFrotz will still print and react faster than you can read or type.

Full color mode will look better for those with Plus! Installed or WinNT 4.X users, because the printed fonts can be automatically anti-aliased if you have selected smooth font display from the Windows control panel.

Updates:
Updates is a setting that applies to both full color and dual color modes; it controls how often WinFrotz chooses to refresh the display as it is printing.  With Very Frequent selected, WinFrotz will update on any change and make sure the screen scrolls smoothly.  This mode can be slow in full color mode if your Windows desktop is in 16/24/32 color depth.  With Frequent selected, WinFrotz will continuously update the display for each line printed or area erased.  With Infrequent selected WinFrotz will update the display only when it is ready for you to read it (at a MORE prompt for instance).  Infrequent mode is faster, but can actually appear slower due to the jerkier nature of the display.

It’s often best to play graphical games in Infrequent mode; that way you don’t watch all of the graphics being updated.  However for text games many people prefer frequent or very frequent. If you find that sometimes the screen appears to not be updated correctly, choose Very Frequent mode and try the same thing again. There is at least one card that exhibits this behavior under Win NT.

Lock Window Size:
Use this option when you are happy with your screen option and don’t want to accidentally resize it.  It will basically prevent you from changing the screen size as long as long as it is checked.

Please note that selecting Lock Window Size and then resizing fonts, especially the status font, can cause some games to corrupt their displays.  This is because WinFrotz will no longer be able to compensate for different font sizes by changing the size of the display itself.

## HIDD_GRAPHICSKK graphics$$ Graphics Options Dialog Graphics Options

This dialog box controls how WinFrotz handles V6version_6 (graphics) story files.  It is broken into three sections:

Emulate:
This box will let you select which PC graphics mode WinFrotz will emulate as it runs the story file.  CGA mode is a two color mode which will use your chosen foreground/background colors.  MCGA mode is a 16 color mode drawn from a large palette and is the recommended choice unless the game you are running doesn’t support that mode.  EGA mode is a 16-color mode with a very limited, fixed palette.  EGA mode typically looks worse than even CGA mode.

Screen Size:
When you run a V6version_6 game, WinFrotz will automatically resize to one of the sizes specified in this box.  This will have no effect on your chosen screen size for other games; it’s particular to V6 games only.  By picking a size here you are determining how far WinFrotz should scale the display - since most of the display modes were far to small or the wrong aspect ratio to display under Windows.

V6 screen sizes are limited to three choices: 640x400, 960x600, and 1280x800.  These work into convenient multiples of the base resolutions used for the original games. WinFrotz will always handle the aspect ratio differences and choice of how to scale on the X and Y axis itself, but the Z-machine games sometimes do not deal with this well at all.  For maximum compatibility it is recommended that you use 640x400 mode (1280x800 will also work well, but it’s pretty large).

Font:
This font is separate from your choices for other types of games (the status and display fonts) and will be used only for V6 games.  It is only font that will be available in your V6 games (although there will still be bold/underlined variants if you choose to display them that way).  WinFrotz will allow you to only pick a fixed-pitch font (required) and will tell you if the size isn’t likely to be compatible.  Many of the V6 games do not work well with particularly large or small fonts.

Even with all the effort WinFrotz makes to correctly emulate the behavoir of the Z-Machine in V6 games, be aware there are a few small quirks left. For instance, in Zork Zero small graphics are used as icons for the room the player has moved to; once in a while the bottom line of these icons will be clipped off the bottom of the screen. This is because the font and screen size you are using is substantially different from the original game, and in a few places the original has hard-coded assumptions of the ratio of the font to the icon size. It can’t be helped in other words, although you can try a slightly different font size to see if it corrects the error.


## version_6KK graphics$$ Version 6 games Version 6 (graphics) games

These games feature graphics displays during the course of the adventure. You must have the actual graphics files, which usually end with a .MG?, .EG?, or .CG? extension, signifying MCGA, EGA, or CGA graphics.  If you don’t have the graphics files for a game that is graphics compatible, check on ftp.gmd.de to see if there are some there (most of them are).  WinFrotz can play these games but there are some caveats due to the substantial difference between the Windows graphics system and the original PC graphics modes; these are fully explained under the View/GraphicsHIDD_GRAPHICS help entry.

## HID_HELP_INDEXIndex command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can jump to step-by-step instructions for using WinFrotz and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.


## HID_HELP_USINGUsing Help command (Help menu)

Use this command for instructions about using Help.

## HID_APP_ABOUTAbout command (Help menu)

Use this command to display the copyright notice and version number of your copy of WinFrotz.  There is also some system information displayed in this dialog box, including the relative speed with with WinFrotz is emulating the Z-Machine (this can be heavily influenced by a variety of factors, so take the number with a grain of salt) and the number of Z-Code operations that have been executed so far in the current story file.

## HID_CONTEXT_HELP$$ Help Using Help CommandContext Help command 
{bml curhelp.bmp}

Use the Context Help command to obtain help on some portion of WinFrotz.  When you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.  Then click somewhere in the WinFrotz window, such as another Toolbar button.  The Help topic will be shown for the item you clicked.

Shortcut
Keys:	SHIFT+F1

## HID_HT_CAPTIONTitle Bar

{bmc hlptitle.bmp}

The title bar is located along the top of a window.  It contains the name of the application and document.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
{bmc bullet.bmp}	Application Control-menu button
{bmc bullet.bmp}	Document Control-menu button
{bmc bullet.bmp}	Maximize button
{bmc bullet.bmp}	Minimize button
{bmc bullet.bmp}	Name of the application
{bmc bullet.bmp}	Name of the document
{bmc bullet.bmp}	Restore button

## scrollbars Scroll bars

WinFrotz does not scroll the main display. It will however scroll in the scrollback mode (Ctrl-L).


## HID_SC_SIZESize command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.
{bml curarw4.bmp}

After the pointer changes to the four-headed arrow:
1.	Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move.  
2.	Press a DIRECTION key to move the border.
3.	Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse:	Drag the size bars at the corners or edges of the window.


## HID_SC_MOVEMove command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow keys.
{bmc curarw4.bmp}

Note:  This command is unavailable if you maximize the window.

Shortcut
Keys:	CTRL+F7


## HID_SC_MINIMIZE$$ System Minimize CommandMinimize command (application Control menu)

Use this command to reduce the WinFrotz window to an icon.

Shortcut
Mouse:	Click the minimize icon {bmc scmin.bmp} on the title bar.
Keys:	ALT+F9


## HID_SC_MAXIMIZEMaximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse:	Click the maximize icon {bmc scmax.bmp} on the title bar; or double-click the title bar.
Keys:	CTRL+F10 enlarges a document window.


## HID_SC_NEXTWINDOWNext Window command (document Control menu)

Use this command to switch to the next open document window.  WinFrotz determines which window is next according to the order in which you opened the windows.

Shortcut
Keys:	CTRL+F6


## HID_SC_PREVWINDOWPrevious Window command (document Control menu)

Use this command to switch to the previous open document window.  WinFrotz determines which window is previous according to the order in which you opened the windows.

Shortcut
Keys:	SHIFT+CTRL+F6


## HID_SC_CLOSEClose command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.
{bml appexit.bmp}


## HID_SC_RESTORERestore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize command.

## HID_SC_TASKLISTSwitch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close an application on the list.

Shortcut
Keys:	CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.  This option does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.  This option does not affect applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.

## AFX_HIDD_FONT$$ Choose Font DialogKK fonts$$ Choose Font Dialog Choose Font dialog box

WinFrotz will always initialize the font dialog box with the currently selected font for the type you want to change, and limit your choices to only valid ones.  You can use the font dialog to preview what the font will look like when it is displayed.  Remember there at times when the font selection will not immediately result in a change in your display, however text printed from that point onward in the font you were changing should reflect the change.

## AFX_HIDD_COLOR## HID_COLORS_USERFG## HID_COLORS_USERBG## HID_COLORS_USERINVFG## HID_COLORS_USERINVBG## HID_COLORS_EMPHASIS## HID_COLORS_BOLD $$ Choose Color DialogKK colors$$ Choose Color Dialog Choose Color dialog box

WinFrotz will allow you to select any color for any item in the Colors menu.  There are certain combinations of colors that could result in difficult or impossible to read displays; if you find the display not making sense after you changed a color, you should probably select a different choice for that color.

The bottom of the choose color dialog box is filled with the custom color palette of WinFrotz.  This is saved and reloaded every time you run WinFrotz; so if you tend to switch between certain colors it makes it easier if you store them here.  The first six colors in this list are reserved by WinFrotz itself and represent the foreground, background, inverse foreground, inverse background, bold and emphasis colors respectively.

## HID_HT_NOWHERENo Help Available

No help is available for this area of the window.

## AFX_HIDP_default No Help Available

No help is available for this message box.


## compatibility Compatibility

It is the goal of the author to make WinFrotz fully Z-Machine compliant; that is, make it able to run all versions of Z-Machine code.  As of this writing WinFrotz can run all Infocom games, including Beyond Zork with it’s special font, and is (as near as I can tell from testing) fully compliant with the Z-machine specification V1.0.

In general WinFrotz does well with all the all games; but there are specific circumstances that can confuse certain stories because WinFrotz features capabilities the original Z-Machine designers never planned for (like dynamic resizing of the display area).  If you are having problems with a particular story, first try selecting an identical fixed pitch font for both the status and display fonts, then resize your screen to 80x25 characters and restart the story.  If you still have problems, e-mail rich@kesmai.com with specifics so I can find out what is causing it.

For Beyond Zork, there is a specific caveat with this release - when running this game, your status (or fixed-width) font must be the same size as an available version of the Beyond Zork graphical font. Currently that is 8,10,12, or 15 points. So before you load Beyond Zork change your status font to a fixed font of one of these sizes - preferably Courier (not Courier New).  If you find the Beyond Zork display still a little corrupted, try some different fonts of that size.  I’m trying to get a TrueType version of the Beyond Zork font to fix this point.

## Infocom Infocom

Infocom is the now defunct company that designed the original Z-MachineZ_Machine concept and wrote the original set of adventure games that became the backbone of the interactive fiction genre (there were plenty of other game companies that produced adventures, but Infocom is generally acknowledged as having the best talent and being the all-around pioneer of the field).

Many people (the author of WinFrotz included) believe that the work done for many of the original, straight text Infocom adventures is some of the best writing ever done for computer game media.  Since the designers were not able to depend on eye catching graphics or surround sound, 3D or any of the techno gadgets found in games today, they concentrated solely on a solid game and writing that was the principle feature, rather than a secondary one, to the story.

Although Infocom no longer exists, the name and game rights to their products are owned by Activision.  Activision has repackaged the original Infocom games in a single CD called The Masterpieces of Infocom which can be purchased for under $20 US dollars.  As there are over 30 games on it, and all are in a format ready to use with WinFrotz, it’s a good companion to WinFrotz.  More information is available from the Activision website at www.activision.com (I do not work for, nor am compensated in any way, by Activision for this product. They were kind enough to select it as a distribution method for a promotional Zork game, but it is not their product!. Please do not call Activision with a WinFrotz problem!).


## get_gamesKK starting$$ Obtaining Story Files Obtaining Story Files

There are several different ways you can obtain story files to play with WinFrotz.  If you own any of the InfocomInfocom adventures, even if they are old, if you can find a way to transfer files from those old disks to your Win95 or NT machine you are probably in luck.  Just look for a file that ends in .DAT, as that is generally the naming convention used by Infocom (it will also usually be the largest file on the disk).  Sometimes for older platforms the story data and executable were merged into one file; for these you may have to look for a utility that splits the files up (read on).

If you want all of the Infocom adventures in a single easy to use place you can obtain the Masterpieces of Infocom disk from Activision (just follow the help link to InfocomInfocom to find out about it).

There are also free story files available.  The most complete location for these is the ftp site ftp.gmd.de which contains just about every piece of interactive fiction written that is publicly available.  Look in the directory /if-archive/games and search around; generally anything that ends with a .dat or .z?? extension is useable (there are story files that cannot be read by WinFrotz because there are other data formats besides the Z-Machine that WinFrotz does not understand).

You can also check the WinFrotz home page at:

http://www.cris.com/~Twist/WinFrotz

Where I intend to keep reasonably up to date links and info on getting games and the latest version of WinFrotz itself.

## edit_keys Editing Keys

Not surprisingly most of the work in WinFrotz is done from a text editing line (most interactive story files being text based).  WinFrotz supports a variety of editing and hot-keys from past versions and also familiar to regular Windows users:

    Alt-A             - alias menu (also Options/Alias)
    Alt-D             - debugging menu (Options/Debugging)
    Alt-N             - new game (restart) (File/Restart)
    Alt-P             - turn on input line playback (File/Open/Recording)
    Alt-R             - input line recording on/off (File/Save/Recording)
    Alt-S             - set the random seed
    Alt-U             - multiple UNDO (even for old V1 to V4 games)
    Alt-X             - exit game (quit)

    Ctrl-A      home              - move to beginning of line
    Alt-B       ctrl-cursor left  - move to previous word
                ctrl-cursor right - move to next word
    Ctrl-B  or  cursor left       - move one character to the left
    Ctrl-D      delete            - delete character below cursor
                ctrl-delete       - delete word below cursor
                insert            - toggle overwrite mode on/off
    Ctrl-E      end               - move to end of line
    Ctrl-F      cursor right      - move one character to the right
    Ctrl-H      backspace         - delete character to the left
                ctrl-backspace    - delete word to the left
    Ctrl-L      scrollback        - view scrollback buffer
    Ctrl-N      cursor down       - get next command
    Ctrl-P      cursor up         - get previous command
    Ctrl-T                        - transpose characters
    Ctrl-U      escape            - delete whole input line


## HIDD_ALIAS_LIST## HID_OPTIONS_ALIAS Alias Menu

WinFrotz allows the creation of alias filesalias_file to make repetitive statements easier to type.  The Aliases... menu item brings up a dialog box that allows you to edit these aliases or abbreviations.

The dialog box will display a list of the current aliases in the form:

text	->	replacement

Where text is what you would type in and replacement is what WinFrotz would replace that with.  The dialog box allows you to highlight an alias and delete it, create a new alias, delete all aliases, and enable or disable aliases (if you disable aliases, your list will be kept, it simply won’t be used until you re-enable them).

## HIDD_ADD_ALIAS Alias Menu

This dialog box will allow you to enter an alias or abbreviation for a section of text. In the first entry box, you type the text you wish to use as an abbreviation, in the second, the text it will be replaced with. So you might type foo in the first entry box and the big foo bar in the second. After that whenever you type foo on a line of text entry, it would be replaced with the big foo bar. Alias entries are not recursive.

## HIDD_DEBUGGING## HID_OPTIONS_DEBUGGING Debugging Menu

This dialog box allows you to turn on various debugging or cheat options for the Z-Machine WinFrotz is running. They are broken down as follows:

Watch Attribute Assignment: Generates messages when the Z-Machine changes the characteristics/attributes of an object in the game

Watch Attribute Testing: As above, shows the testing of the attributes on an object.

Watch Object Movement: Generates messages as the Z-Machine moves objects around (non player characters are thought of as objects so you can watch them move with this).

Watch Object Locating: Generates messages when objects are located

Set Piracy Bit On: Turns the piracy bit on for the game, although no games are known to use this.

Set Tandy Bit On: Several Infocom games will behave slightly differently with the Tandy bit set, censoring some words for this family brand that was sold through Radio Shack.

All options in this menu apply only to that session of use. They are not saved in the registry as this would lead to confusion and problems with overly verbose output.
## HIDD_SOUND## HID_OPTIONS_SOUNDKK sound$$ Sound Dialog Sound Dialog

The sound dialog box simply allows you to specify whether WinFrotz will attempt to play sounds in those games that support it (Sherlock and Lurking Horror, currently).  You might select this off if you are having problems with sounds, or you don’t want to hear them.

In addition you can adjust the volume with which sounds are played.  This volume is relative to your current wave output volume specified in the Windows sound control panel.  If you have the slider all the way to the right, WinFrotz will play sounds at the maximum volume for wave output, not at the maximum volume your sound system is capable of supporting.

This dialog will also indicate whether the story file you are using has even attempted to load and play a sound yet. This can be a useful diagnostic if you are trying to determine whether the story file is sound-capable or not; not all versions of Lurking Horror or Sherlock even play sounds (complete documentation on how to modify them is at ftp.gmd.de). It may also just indicate that you haven’t reached a point in the game where it tries to play a sound yet.

Sound settings are saved in the Registry so WinFrotz will remeber what volume you want, etc.
## HIDD_SCROLLBACKKK transcript$$ Viewing Scrollback Buffer

The scrollback buffer displays the last 32K or so of the transcripttranscript_file that is recording while the story file is played.  You can use the scrollback to copy text that you want to input; simply highlight the text using the mouse or arrow keys and use the standard windows Ctrl-C to copy it to the clipboard.  Once back to the WinFrotz entry line, use Ctrl-V to paste it in.

The scrollback buffer is read only (you can’t insert text here) and possibly represents only part of the entire transcript; the most recent part.  To obtain a record of the entire transcript save it to disk using the File/Save/Transcript menu entry.

## HID_OPTIONS_AUTO_LOAD Auto Load

Using this allows you to mark a story file as the automatic default to load when WinFrotz is started.  This can come in handy when you are repeatedly playing the same story to completion; you just double click and it loads (you’ll still have to load the appropriate save game).

In the dialog box you can either edit the file name shown directly, or browse for it Explorer-style by clicking the Browse button.  You can turn the feature off by clicking the ‘Disable auto-load feature’ button.

Entering an incorrect file name, or having a file name that later becomes invalid (deleted, etc) will not cause problems.  WinFrotz will just skip the load if it can’t find the file

## HID_OPTIONS_UNDO_GAME Undo Last Turn

This allows you to take back your last action in the game (defined by the last time you hit return on a line) without consequences; it will be as if it never happened.  You can even multiple-undo to go back several steps.

However there are a few things to keep in mind.  If you make a truly fatal mistake, and you die, you probably won’t be given a chance to take it back - you’ll only be able to reload the game.  Also some Z-Machine games support this feature directly and may have their own ideas about what you can and cannot Undo.

Undo is not a substitute for a saved game.  Follow the adventurer motto - save early, save often.

